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Introduction
Introduction

What is Grasshopper?

Grasshopper (GH) is a component-based algorithm editor integrated with Rhino modeling tools. 
Algorithms are used to describe logical relationships among design parameters that define the 
parametric model. Through algorithms, the user is able to establish a set of rules that define the 
sequence of operations, thus aiding the design process. 

What is the purpose of the Grasshopper-ARCHICAD Live Connection tool? 

The Grasshopper-ARCHICAD Live Connection offers a unique, algorithm-based workflow, which 
helps you explore a large number of design variations and create and fine-tune building details and 
structures - without exchanging files.

Key features and benefits

• Translate simple geometry created in Rhino into BIM construction elements 

• Bi-directional connection – no need to export/import file for data exchange

• Dynamic (live) connection while editing

• Direct and simultaneous graphical feedback from both Rhino and ARCHICAD

Supported workflows

This set of tools enables Rhino/Grasshopper (GH) and ARCHICAD (AC) to communicate directly. 
Designers working in either Rhino/Grasshopper or ARCHICAD can utilize its functionality to their 
advantage. Users can start the design process in either work environment (AC or RH or GH). In each 
case, the user will select an original set of reference geometries to be manipulated via 
Grasshopper, or create it from scratch in Grasshopper. 

•  “Start with pure 3D geometry” workflow: Designers start with the design geometry using 
Rhino and Grasshopper. With the “GH-AC Connection” tool, they can dynamically generate a 
BIM model consisting of ARCHICAD construction elements, and update the resulting BIM model 
directly from Grasshopper. 

• “Start with intelligent building elements” workflow: Designers start with the design in ARCHICAD 
and extend their AC toolbox with algorithmic design methods applied to AC elements. In this 
workflow, input reference geometries (reference points, curves and other parameters) are taken 
directly from ARCHICAD and used in Grasshopper, without interaction in Rhino.

Scope of the manual

This manual is intended to explain only the added functionality of creating ARCHICAD elements 
from Grasshopper. The general description of functionality of ARCHICAD, Grasshopper or Rhino is 
not in the scope of this manual. To acquire the necessary basic knowledge in these applications, 
please visit the following sites.

• Grasshopper Training Center: http://www.grasshopper3d.com/page/tutorials-1

• ARCHICAD Training Materials: http://www.graphisoft.com/learning/training_materials/

• Rhinoceros3D Learning Center: http://www.rhino3d.com/learn
Grasshopper-ARCHICAD Live Connection 2.3 User Guide 4

http://www.grasshopper3d.com/page/tutorials-1
http://www.graphisoft.com/learning/training_materials/
http://www.rhino3d.com/learn


Getting Started
Getting Started
To achieve a connection between the ARCHICAD and Grasshopper applications, you must install a 
GRAPHISOFT extension: the Grasshopper – ARCHICAD Live Connection.

Install the Add-On

1. Make sure that ARCHICAD 23 (latest update) is already installed on your computer.

2. Make sure that no other version of Grasshopper-ARCHICAD Live Connection is already installed! 
If you already have one (e.g. a previous version), you must uninstall it before proceeding.

3. Make sure that Rhino is installed on your computer.

– With either Windows or macOS, use Rhino Version 5 or Version 6, 64-bit

Important: Grasshopper for Mac is currently at a “Work in Progress” stage of development. It 
does not yet contain all of the features available in Rhino for Windows. For details, see: 
https://www.rhino3d.com/mac-feature-compare.

4. Launch the Setup Wizard of the Connection add-on and go through the steps as shown on the 
setup screens.

Launch the Applications

1. Launch ARCHICAD.

2. Launch Rhinoceros 3D (Rhino).

3. From Rhino, launch Grasshopper: Type the word “Grasshopper” into the Rhino Command Line 
and hit ENTER.
Grasshopper-ARCHICAD Live Connection 2.3 User Guide 5
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Getting Started
Notes: 

– Once all three applications are running, it is recommended to arrange the windows so that 
they do not overlap. (For ease of use, use multiple screens).

– To receive notifications and information from the add-ons, turn on the Status bar palette in 
ARCHICAD (Window > Palettes > Status bar).

Start the Connection

• In ARCHICAD, go to File > Interoperability > Grasshopper Connection.

• A small floating palette appears with the “Start Connection” button on it. Click to start the 
connection. 

Grasshopper Palette in ARCHICAD

To open the Grasshopper palette in ARCHICAD, go to File > Interoperability > Grasshopper 
Connection. 

Note: Like any other palette in ARCHICAD, the Grasshopper palette is also available from 
Window > Palettes.

The palette contains 3 buttons:

• Live Connection: Click to turn on/break the connection between 
Grasshopper and ARCHICAD. 

• Send Changes: Updates Grasshopper about changes made in ARCHICAD. If 
this button is activated, then Grasshopper is continuously and automatically 
updated based on changes to connected elements in ARCHICAD. This may 
take time. To avoid delays during these updates, deactivate the button - in 
this case, Grasshopper will not automatically reflect the model changes in 
ARCHICAD.
Grasshopper-ARCHICAD Live Connection 2.3 User Guide 6



Getting Started
• Lock/Unlock GH Elements: Use this control to unlock the elements generated in Grasshopper. 
Unlocked elements can be freely modified in ARCHICAD. Click again to lock the elements: now 
the elements revert to their status as defined in Grasshopper (e.g. CW Curve Geometry). 
However, any parameters that cannot be not set in Grasshopper, and which you set in 
ARCHICAD while the elements were unlocked (e.g. a CW Panel’s Building Material), will retain 
those ARCHICAD settings even after elements are re-locked. 

• Select in GH: In Grasshopper, selects the components which generated the elements currently 
selected in ARCHICAD. This button is active only if the current ARCHICAD selection includes at 
least one element generated by the Grasshopper code. 

Notes: 

– If the green icon is spinning, this indicates that the connection with Grasshopper is live, and 
ARCHICAD is now ready to send and receive information.

– The palette also tells you which currently opened Grasshopper document is connected to 
ARCHICAD.

– At the bottom of the palette, a green progress bar appears during time-consuming updates.

– Click the info icon at top left to open a palette: this displays Connection Status, the path of 
the connected file, and the Port Number. If the selected port is occupied by a different 
application, you are prompted (“Set Port”) to choose a different port.
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Getting Started
ARCHICAD Tab in Grasshopper

In Grasshopper, a new “ARCHICAD” tab has appeared on Grasshopper's tab bar. The icons on this 
tab resemble those of ARCHICAD tools; they represent element-based Components, Parameter 
Components and Input Components.

Command in Grasshopper’s File menu

In Grasshopper, a new command appears in the File menu: “Connect Document to ARCHICAD”. 
This command opens a dialog box: among the currently open Grasshopper files, choose the one 
that should communicate with ARCHICAD.
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Getting Started
Preview Option in Grasshopper’s Display Menu

Most components of Grasshopper-ARCHICAD Connection generate a detailed preview in Rhino, 
using colors that match those of the ARCHICAD model. However, generated Library Parts (Object, 
Window, Door) display only a bounding box as a preview, by default. (Otherwise, the high polygon 
count might affect performance.) 

To see a detailed preview of Library Parts in Rhino (instead of just the bounding box), turn on the 
Detailed ARCHICAD Preview toggle in Grasshopper’s Display menu.
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Uninstall Grasshopper Connection
If you uninstall Grasshopper Connection, make sure you follow these steps - otherwise, you may 
run into errors when reinstalling.

Windows

Remove the application using the “Apps & features” utility, accessible from Windows Settings.

Mac (GH Connection for AC22 and up)

1. Go to the ARCHICAD folder where Grasshopper Connection is installed

2. Run the following app: Uninstall.GC

Mac (GH Connection for AC21 and earlier)

1. Go to the ARCHICAD folder’s Add-On\Local folder.

2. Delete the following items from the Local folder:

– GrasshopperConnection 

– ProductVersion.xml

3. Go to the following folder: ~/Library/Application Support/McNeel/Rhinoceros/MacPlugIns/
Grasshopper/Libraries/ARCHICAD xx (where xx is the ARCHICAD version number)

4. Delete the ARCHICAD xx folder (it contains a file named ArchiCADConnection.gha)

5. Go to the Terminal App window. 

6. Copy-paste the following line, then press Enter:

sudo pkgutil --forget "com.graphisoft.ArchiCAD.Goodies.GHACLiveInstaller"
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ARCHICAD Components
The ARCHICAD tab page in Grasshopper contains Parameter components, element-based 
component, and Input components. Parameter components store geometric information; element-
based components perform the operations that generate data; input components provide access to 
certain ARCHICAD value sets.

Parameter components refer to point coordinates or existing 2D or 3D geometry 
in the ARCHICAD project. Most of the Parameter components represent special 
ARCHICAD data that can be interpreted only by other ARCHICAD Components. 
However, in the case of Point, 2D Curve, and Spline Parameter components, the 
referenced geometry can be transformed by regular Grasshopper components 
(such as Move) in the usual way, and can also be used as the initial input for GH 
code.

See details at ARCHICAD Parameter Components.

Design and Document components generate native 2D or 3D elements 
in ARCHICAD - such as Polylines, Walls, Objects, and Windows.

At present, Grasshopper components can interpret output only from 
the Spline and 2D Curve components, because these are automatically 
converted to the native Grasshopper Curve data type.

The rest of the ARCHICAD components generate a special type of data that cannot be 
converted into built-in Grasshopper data types. For this reason, Grasshopper operations 
(such as the Move component) cannot be carried out on the geometry generated by the 
AC components. The AC components can be placed downstream from the GH 
components, but the Grasshopper definition ends there.

See more details at ARCHICAD Document Components and ARCHICAD Design Components.
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Deconstruct components: These are used to break down 2D and 3D 
ARCHICAD elements into their constituent parts. 

Deconstruct components are the inverse of the element-generating Design 
and Document components. Use Deconstruct components to access the 
geometry data of the input ARCHICAD elements. A Deconstruct component 
can also reference an existing, manually placed ARCHICAD element.

See more details at ARCHICAD Deconstruct Components.

Settings components are available for each Design and Document 
component. The Settings component sets parameter values for the element 
generated in ARCHICAD. Attach a Settings component to the “Settings” 
input parameter of the data-generating component.

Extract Settings components: 
Extract Settings components are the inverse of the Settings components: they 
break down the ARCHICAD element Settings data referenced at input. Use 
Extract Settings components to get these element settings for use in another 
operation.

See more details at ARCHICAD Extract Settings Components.

Reshape components can modify elements produced by certain ARCHICAD components 
(Fill, Slab and Roof components). Currently there are two Reshape components: the 
Subtract Polygon and the Add Polygon.

See more details at ARCHICAD Reshape Components.

Input components: An input component stores a list of values received from 
ARCHICAD. The available values are continuously refreshed, so that they always 
correspond to the set of values contained in ARCHICAD. At present, twelve input 
components are available: 2D Viewpoint, Composite, Fill Pattern, Line Type, 
Profile, Surface, Building Material, Favorite, Layer, Pen, Story Plane and Zone 
Category.

Place ARCHICAD Components

The ARCHICAD (AC) components available on Grasshopper’s ARCHICAD tab work the same way as 
other components or parameters in Grasshopper. Use the familiar methods to place them on the 
Grasshopper canvas. After the required input parameters are received, a preview is immediately 
visible in the Rhino window.
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ARCHICAD Parameter Components
AC Parameter components refer to point coordinates or existing 2D or 3D 
geometry in the ARCHICAD project.

Most of the Parameter components represent special ARCHICAD data that 
can be interpreted only by other ARCHICAD components. However, data 
stored by the AC Point, AC Spline and AC 2D Curve Parameter components 
can be converted automatically by Grasshopper into native Point and Curve 
data. Therefore, these three Parameter components are an integral part of 
the Grasshopper code.

AC Point Parameter Component

Like Grasshopper’s Point parameter, the ARCHICAD Point parameter 
(AC Point) can store 3D point data. This data is defined in ARCHICAD, 
not in Rhino. The AC Point parameter can reference a single or multiple 
3D points.

Set One Point

1. In Grasshopper, right-click on the center of the AC Point. 

2. Select ´Set One Point in ARCHICAD´ from the context menu. (The 
Rhino and GH windows close. In ARCHICAD, notice that the Status 
Bar displays the message: “Click a point”.)

3. Click in the ARCHICAD window to define the origin of the AC Point. 
(If the point is selected successfully, the Rhino and GH windows 
appear again, and the parameter component turns from yellow to 
gray, to indicate that it is not empty.)

4. Now continue working as needed in ARCHICAD, or return to 
Grasshopper.

Note: The value stored in the parameter component can be 
redefined at any time using the “Set One Point” or “Set Multiple Points” commands. 

Set Multiple Points

1. In Grasshopper, right-click on the center of the AC Point.

2. Select ´Set Multiple Points in ARCHICAD´ from the context menu.

3. Click several times in the ARCHICAD window to define a collection of points.

4. Click ESC to exit input mode.
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Note: The AC Point component converts the point defined in ARCHICAD into a Grasshopper 
Point parameter. This AC Point parameter component can then be assigned to any GH 
component that requires a GH Point-type input.

To define the origin of an AC Point, you can also click on any hotspot of a placed ARCHICAD 
element. In this case, the AC Point will remain associated to its parent element in ARCHICAD.

For example:

1. In Grasshopper, place two AC Point parameter components.

2. To define their origins, go to ARCHICAD and click the endpoints of an already placed Beam 
element.

3. In ARCHICAD, move the Beam to a new position.

4. Click the ‘Send Changes’ button on the Grasshopper Connection Palette: the coordinates stored 
in the AC Point parameters are modified to match the Beam’s new position.

2D Curve and Spline Parameter Components

2D Curve Parameter component can reference one or more 2D elements drawn in ARCHICAD with 
the Line, Polyline or Circle Tool, while the Spline Parameter component does the same for elements 
created with the ARCHICAD Spline tool. 

Note: You can use the 2D Curve or Spline Parameter component to reference any Polyline, 
Circle or Spline element drawn in any 2D ARCHICAD Viewpoint (Floor Plan, Section, Elevation, 
etc.). However, in Grasshopper, the new planar shape will always be drawn in the XY plane.

Referencing a polyline in ARCHICAD:

1. Draw a polyline in ARCHICAD with the Polyline Tool.

2. In Grasshopper, place an AC 2D Curve Parameter component and right-click on its center.

3. Select ‘Set One 2D Curve’ from the context menu. (The Rhino and GH windows close. In 
ARCHICAD, notice that the Status Bar displays the message: “Click an element”.)

Note: If any ARCHICAD elements are selected at the time you issue the ‘Set One 2D Curve’ 
command, and if the set of selected elements includes one element drawn with the Polyline/
Line/Circle Tool, then the parameter is automatically defined according to the selected 
element, and no further element selection is needed. If the selection does not include a 
Polyline/Line/Circle element, or if there are multiple selected Polylines/Lines/Circles, then the 
program will deselect the elements, and prompt you to select elements in ARCHICAD.

4. Click on the previously drawn polyline in the ARCHICAD window. The 2D Curve Parameter 
component is now referencing the selected ARCHICAD element.
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ARCHICAD Components
The 2D Curve and Spline parameter components remain associative to their parent element in 
ARCHICAD. After editing the referenced element in ARCHICAD, press the ‘Send Changes’ button on 
the Grasshopper Connection Palette to update the information stored in the 2D Curve or Spline 
parameter component.

Note: The AC 2D Curve and Spline parameter components are compatible with the GH Curve 
parameter. Thus, they can be used as the input for any GH component that accepts the GH 
curve type as an input.

Naturally, you can use the 2D Curve or Spline Parameter components to reference multiple 
ARCHICAD Polyline, Spline, Line or Circle elements. To do this, use the “Set Multiple 2D Curves” 
command from the context menu. 

Note: If any ARCHICAD elements are selected at the time you issue the “Set Multiple 2D Curves” 
command, and if the set of selected elements includes at least one element drawn with the 
Polyline, Circle or Line Tool, then the parameter is automatically defined according to the 
selected element, and no further element selection is needed.

Fill, Roof, Slab Parameter Components

Data in Fill/Roof/Slab Parameter components cannot be converted to native Grasshopper data 
types. For this reason, Grasshopper operations (such as the Move component) cannot be carried 
out on them.

However, data of the Fill/Roof/Slab Parameter components can be used by the Reshape and 
Deconstruct components.
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ARCHICAD Components
To add or change data in a Parameter component: use the commands from the context menu (e.g. 
“Set One Roof”/“Set Multiple Roofs”), as described for 2D parameter components, above.

Note: The Roof Parameter Component can reference only Single-Plane Roofs in ARCHICAD (that 
is, simple roofs consisting of a single plane). Roofs created with the more complex, Multi-Plane 
Geometry method are currently not handled.

Wall Parameter Component

Data of the Wall Parameter component can be used by ARCHICAD Connection’s Deconstruct Wall 
component and by the Door/Window-type Design components.

To add or change data in a Parameter component: use the commands from the context menu (e.g. 
“Set One Wall”/“Set Multiple Walls”), as described for 2D parameter components, above.

Other 3D Parameter Components

Data of other 3D Parameter components - Beam, Column, Curtain Wall, Door, Mesh, Morph, 
Object, Shell, Window and Zone - can be used only by the corresponding Deconstruct components. 

To add or change data in a Parameter component: use the commands from the context menu (e.g. 
“Set One Beam”/“Set Multiple Beams”) as described for 2D parameter components, above.

Modify Information Stored by Parameter Components

The content of Parameter components in ARCHICAD can be redefined, deleted or updated at any 
time. To redefine the stored value, use the “Set One Element” or “Set Multiple Elements” 
commands from the context menu. 

See description at AC Point Parameter Component.

• To clear the parameter values entirely, use the “Clear Values” command from the context 
menu.
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• Information stored in a Parameter component is updated automatically if the 
referenced element has been changed in ARCHICAD - provided that the “Send 
Changes” button on ARCHICAD’s Grasshopper palette is activated. If “Send 
Changes” is not active, then Grasshopper will not reflect the modifications to 
referenced ARCHICAD elements.
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The Synchronize Parameter
All AC components that generate ARCHICAD elements (Document and Design components) include 
“Synchronize” as an input parameter. It is a Boolean type parameter which enables components to 
communicate with ARCHICAD. 

If a component’s Synchronize parameter is set to TRUE, changes made to that component will be 
synchronized with ARCHICAD automatically.

If Synch is set to FALSE, the component will not generate any element, and will return a single 
“Null” value, regardless of the number of input parameters.

Note: Synchronization works only if ARCHICAD’s Grasshopper Connection is on: that is, the 
green icon on the Grasshopper Connection Palette is spinning.

Tip: You can attach a single Boolean Toggle component to the Synchronize parameters of 
several components (as shown in the illustration below). This way, you can control the 
Grasshopper-based connection to entire parts of a building via a single toggle. Just switch the 
Boolean Toggle to FALSE to turn off the synchronization function for those parts of the building 
that are not being modified. As a result, working with Grasshopper-ARCHICAD Connection 
becomes more efficient: only the affected parts of the model are recalculated.
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ARCHICAD Document Components
Document components generate 2D documentation elements in ARCHICAD. There are 
three Documentation components so far: the 2D Curve, the 2D Fill and the 2D Spline 
component. All of them have two required input parameters: the Curve parameter 
defines the shape of the newly created planar element, while the 2D Viewpoint 
parameter determines the 2D Viewpoint (Section, Floor Plan etc.) of ARCHICAD onto 
which the new element will be placed.

Note: ARCHICAD’s documentation elements – such as those created by the Fill, Line, Circle, 
Spline and Polyline tools – are not visible in 3D views, only in 2D views (Floor Plan, Section, 
Elevation, Interior Elevation, etc.). Therefore, only 2D viewpoints can be used as the input 
parameter for the 2D Curve and 2D Spline Components.

Choosing the Viewpoint:

1. Place a 2D Viewpoint Input Component, then connect it to the “2D Viewpoint” input parameter 
of the 2D Curve or Fill component. 

2. Click on the right side of the 2D Viewpoint Input Component. A tree structure appears, 
corresponding to the ARCHICAD project’s Project Map.

3. Choose the desired Viewpoint, then click Select. 

See also 2D Viewpoint Input Component.

Note: The 2D Curve and Fill components will accept only curves lying on a single plane as inputs. 
The input curves defined in Grasshopper can also be planar splines, but ARCHICAD will segment 
these, creating segmented Polylines.

At present, it is not possible to attach additional GH components to the right side of Document 
components (e.g., you cannot transform them with the Move component), because the data 
output by the Document components are not recognized by the GH components. However, Fill-type 
data created with the Fill component can be used as input by Reshape components (Add/Subtract 
Polygon).
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2D Curve Component

This component generates curves (defined in Grasshopper) in a selected 2D Viewpoint of the 
ARCHICAD project. The curves created in ARCHICAD will be Polylines. If you want to define the 
ARCHICAD Layer, the Line Pen or Line Type of these Polylines, attach a Polyline Settings component 
to the Settings input parameter of the 2D Curve Component.

2D Spline Component

This component works the same way as the 2D Curve Component, except that it generates Spline 
elements in ARCHICAD. The Spline Settings component, in addition to Pen and Layer options, 
includes two Boolean (TRUE/FALSE) options: you can choose to generate a normal vs. Bézier curve, 
or Open vs. Closed-ended Spline.
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2D Fill Component

The Fill component will create Fill elements (that is, 2D hatches) in ARCHICAD. Like the 2D Curve 
component, the Fill component has two required input parameters: a Polygon (defined by a planar 
closed Curve-type or planar Surface-type geometry) and a 2D Viewpoint.

Use the Fill Settings component to define the attributes of the generated element (use the Pen, 
Line Type and Fill Pattern parameters), its Layer (use the Layer parameter), and/or to show its Area 
Text.

Note: Right-click the Fill Settings component 
to open the context menu, where you can 
define the Fill category of the newly created 
Fill element. If you choose “Cut – Building 
Material”, then you can use the Building 
Material parameter (instead of the Fill 
Pattern) to define the pattern of the Fill 
element to be created in ARCHICAD.

2D Text Component

Use this component to create Text in ARCHICAD. It has three required parameters: the text itself, 
plus Insertion Point and 2D Viewpoint.
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Use Text Settings to control:

• Font Name (e.g. Calibri, Ariel) - use the Font Name parameter component

• Font Size

Note: This value uses Rhino’s units. If Rhino is set to use meters, then font size is also set in 
meters.

• Font Pen - use the Pen Parameter component

• Font Style (e.g. Plain, Bold, Italic, or a combination style) - use integer value

• Alignment (Left/Center/Right/Justified) - use integer value

• Leading - use number value

• Width Scale - use number value

• Spacing Scale - use number value

• Layer

• Renovation Status
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ARCHICAD Design Components
The Design components generate native 3D elements in ARCHICAD 
Their input parameters must be geometric information (point, curve, 
etc.) which define the new elements’ position. Most of them have a 
single output parameter which stores geometric information.

The outputs of AC Design components currently cannot be used as 
inputs for the transforming components in GH (such as Move). For some 
components, however, the output data can be re-used as inputs for other AC elements (for 
example, the Window component requires a Wall-type input; the Reshape components accept Fill, 
Slab and Roof type inputs).

Important: If a Grasshopper component (e.g. Slab) is assigned multiple curves as input 
parameters, then ARCHICAD will generate a corresponding number of Slabs, each of which is 
separately editable in ARCHICAD.

To refine a Design component’s geometry or attributes, you can attach the corresponding Settings 
component. By default, Settings parameters initially inherit the values set in ARCHICAD (in the Tool 
Default Settings dialog of the corresponding tool). In Grasshopper, use familiar methods to override 
these default values (e.g. attach a Number Slider component). 

See ARCHICAD Settings Components for details.
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Note: Many ARCHICAD-based parameters of design elements are not yet available for 
Grasshopper’s AC components. The value of these parameters, at the time the component is 
first generated, will equal the current default value set for the corresponding tool in ARCHICAD.

Column Component

The AC Column component requires two points as input parameters. Based on these, Grasshopper 
will generate ARCHICAD columns along the defined segments (which serve as the column axes). 

Connect a Column Settings component to the Column Settings input parameter to control the 
Building Material, Layer and additional geometric parameters.

Through the context menu of the 
Settings component, you can define the 
column profile (Rectangular, Circular or 
Complex Profile). 

Notes: 

– You can also attach an AC Point 
parameter to an AC Column 
component, because AC Point 
data is compatible with GH Point 
data.

– Defining the end point of the 
Column is optional. If you leave it 
undefined, you will get a straight 
column with default height (the current height set in the Column Default Settings dialog in 
ARCHICAD).
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Slab Component

The AC Slab component generates an ARCHICAD Slab element. The required input parameter is one 
or more closed polygons defined by the planar surface of Curve type data. Because ARCHICAD can 
interpret only horizontal slabs, the input polygons must be in the XY or parallel plane. 

The input geometry may be: 

• a Grasshopper Curve parameter referencing one or more selected closed curves in Rhino,

• a Grasshopper Surface parameter referencing one or more planar surfaces which may also have 
holes in them,

• any closed planar Curve or planar Surface geometry generated by a Grasshopper Component, 

• a 2D Curve parameter referencing a closed ARCHICAD polyline element.

Important: In Rhino, you can select a curved spline as the input parameter for the AC Slab 
component, but the outline of the corresponding Slab generated in ARCHICAD will be 
segmented.

Use the Slab Settings component to access additional parameters. Open its context menu to define 
the Structure (Basic or Composite) of the generated Slab elements; the set of available input 
parameters will change accordingly.
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Wall Component

The AC Wall component generates ARCHICAD Wall element(s), based on one or more lines, 
polylines, or open or closed curves. The input geometries must be in the XY or a parallel plane.

Important: If you select a Rhino spline as input curve parameter for the AC Wall component, 
then the resulting element in ARCHICAD will not be a single curved Wall, but rather a chain of 
Walls, whose segments correspond to the spline segmentation.

To access additional parameters – such as Layer, Height or Building Material – connect a Wall 
Settings component to the Wall Settings parameter.

Use the Wall Settings component's 
context menu to set the Structure 
(Basic, Composite or Complex Profile), 
Geometry Method (Straight or 
Trapezoid), and Reference Line 
Location of the generated Wall 
elements. Depending on Structure and 
Geometry Method values, the rest of 
the available parameters will vary.
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Beam Component

The AC Beam component generates ARCHICAD Beam element(s) along one or more lines, polylines, 
or open or closed curves. These curves may be in 3D space.

Important: 3D curves will be segmented in ARCHICAD. Therefore, the geometry generated by 
the AC Beam component will produce not a single curved Beam, but rather a chain of beam 
segments.

Attach a Beam Settings component and 
open its context menu to decide what 
kind of cross-section the generated 
Beam elements should have 
(Rectangular or Complex Profile).

Based on this choice, the Settings 
component will contain further 
parameters, such as Profile Rotation, 
Axis Offset, and Building Material.
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Morph Components

There are two kinds of Morph components:

• The Morph Curve component transforms the Curve from Rhino into an ARCHICAD Morph curve.

• The Morph Solid component transforms Mesh geometry from Rhino into a solid ARCHICAD 
Morph.

With the help of the Morph Settings component, you can assign a Building Material to your newly 
generated Morph element, and you can decide which ARCHICAD layer it should appear on.

Note: In Grasshopper, you can also use Box, Surface, or BREP-type values as Mesh inputs for a 
Morph - since these values are converted into the Mesh type automatically. When using BREPs, 
it is recommended to also use the “Mesh-Brep” converting component in GH, to help keep 
polygon count under control.

Note: The Weld Edge information is stored in the Morph component. Thus, the Weld Edge 
information applied to the input Mesh will also be applied to the Morph element generated in 
ARCHICAD.
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Roof Component

The Roof component requires a planar polygon input geometry for generating an ARCHICAD Single-
plane Roof. This input polygon may be defined by a Curve-type or Surface-type data that can lie in 
any plane, thus defining not only the Roof contour but also its pitch and elevation.

You can determine the Structure type (Basic or Composite) of the element through the context 
menu of an attached Roof Settings component. Depending on the selected Structure value, the 
Settings component will include Composite or Building Material as an input parameter.

Note: The planar curve or surface used for the polygon input defines the 3D location and plane 
of the Single-plane Roof element generated by the Roof component. Thus, the Offset from 
Home Story and Roof Pitch parameter values (stored in the Favorites of the Roof Settings input) 
has no effect.
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Shell Components

The ARCHICAD Shell tool has three Geometry Methods - Revolved, Extruded, and Ruled. ARCHICAD 
Connection provides a separate component for each. Each component has two required input 
parameters, whose type is either Curve, Vector or Axis. 

Each of the three Geometry Methods has its own Settings component. Use the Settings component 
context menu to define the generated element’s structure: Basic or Composite. In addition, you can 
use the Settings parameters to fine-tune the Shell geometry or define its Building Material/
Composite attribute.
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Mesh Component

This component generates an ARCHICAD Mesh element based on the 3D coordinate set it receives 
as input. The input must consist of a set of at least three points.

Use the Mesh Settings component to define Building Material, Height, and Layer. Use the Structure 
input to set the Mesh display as either Solid or Surface only.
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Curtain Wall Components

To generate a Curtain Wall element from Grasshopper, use the following four components:

Curtain Wall Component

Generates a Curtain Wall by extruding the reference line (defined by the Curve input). The 
extrusion is perpendicular to the plane of the Curve input. The height of the generated Curtain Wall 
is defined in the Domain input, and its External Side is defined by the point-input value of the same 
name.

Note: Use the Construct Domain Grasshopper component to define the Domain input 
parameter. If the Domain Start parameter value is negative, then the extrusion will extend 
below the reference line (in the negative Z direction). 

– Example: If the Domain value is “-2 to 3”, then the generated Curtain Wall will be 5 meters in 
height, and will begin at a point two meters below the reference line.

Curtain Wall Segment Component

Works similarly to the Curtain Wall component, but here you can only create a single Curtain Wall 
segment (its input reference line is a Line, rather than a Curve). The component also requires a 
Plane Point input parameter. The extrusion is perpendicular to the reference plane defined by the 
Line and Plane Point inputs. The Plane Point also defines the Curtain Wall External Side.
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Curtain Wall Boundary Component

Generates a Curtain Wall element with a Boundary of a freely defined shape. The plane and shape 
are defined by the closed polygon given as the Boundary input parameter. Here, too, an input point 
defines the External Side.

Curtain Wall Boundary Custom Component

A modified version of the CW Boundary component; use it to create a Curtain Wall with a custom 
pattern. The custom pattern is defined using a set of lines created in either Rhino or Grasshopper.

The component’s top four input parameters are the same as those of the regular Curtain Wall 
Boundary component. However, there is an important difference: in the Boundary Custom 
Component, if you assign CW Settings input parameters (by attaching a CW Settings component or 
Input component), these will not affect the Curtain Wall Scheme Settings (a pop-up note will alert 
you of this). The reason: the Boundary Custom component ignores the Grid pattern defined in 
Scheme Settings, and instead uses an empty Boundary Frame as the starting point. This is the 
“blank slate” on which the custom pattern is created. Apart from Scheme Settings, all other CW 
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Settings values (e.g. Layer, Home Story, properties) will have the expected effect in the Boundary 
Custom component.

Custom Frame Inputs

• Custom Frame Axes: Expects a set of lines. Each line defines the length of the custom frame’s 
axis. Each line must lie in the plane of the Boundary Frame, and all of its points must line within 
the Boundary. 

– Tip: As needed, use the Trim with Region component from Grasshopper to achieve this.

• Frame Settings: A special parameter with data type of “CW Frame Settings”. Defines the Frame 
types (Frame Class) used to construct the Curtain Wall generated by the component. Add new 
items by using the CW Frame Settings Component or Favorite Input Component. Based on the 
Classes defined in Frame Settings, you can then input a Custom Frame Class or Boundary Frame 
Class for any Curtain Wall Frame. 

If you do not assign input values to the Frame Settings parameter, then the CW will be 
generated in ARCHICAD using only the four “built in” Frame Classes: Corner, Boundary, Division 
or None. These classes will be used depending on the value set for the Custom Frame Class and 
Boundary Frame Class input parameters (hover over the input parameter to see the available 
values). If you do assign input values to the Frame Settings parameter (e.g. via CW Frame 
Favorite), this expands the set of available inputs for the Custom Frame Class and Boundary 
Frame Class parameters.

• Custom Frame Class: Expects a set of integers. These inputs define the geometry of the Custom 
Frames: each integer represents a Frame Class. (Hover over the input parameter to see the 
available values.) The Corner, Boundary, Division and None classes are always available, plus 
any additional values corresponding to Frame Classes added via the Frame Settings parameter.

• Boundary Frame Class: Expects a single integer parameter. This defines the geometry of the 
Boundary Frame (which is uniform along its entire length). Hover over the input parameter to 
see the available inputs for this parameter.
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Custom Panel Inputs

• Panel Points: Use this parameter to define the type (Panel Class) of each Panel created within 
the custom Frames.

This input parameter expects a list of points. Each point is assigned a Panel Class (this 
assignment takes place via the Panel Class input parameter). 

Grasshopper assigns Panel Class to each Panel Point as follows: in each Panel, it locates the 
point nearest to its center of gravity, then assigns the Class of that point to the Panel. 

If the component’s “Check Panel Region” option (available in the context menu) is OFF, then a 
Panel Class is assigned even if the nearest point falls outside of the Panel boundary. If the 
option is ON, then a Panel Class is assigned only if the Panel contains at least one point within its 
boundary. All other Panels keep their default “Deleted” status.

• Panel Settings: A special parameter with data type of “CW Panel Settings”. Defines the Panel 
types (Panel Classes) used to construct the Curtain Wall generated by the component. Add new 
Panel Classes by using the CW Panel Settings Component or Favorite Input Component. Use the 
Panel Classes defined here as inputs for the Panel Class input parameter.

If you do not assign input values to the Panel Settings parameter, then all panels of the 
generated Curtain Wall will retain their default “Deleted” status - that is, empty.

• Panel Class: Expects a set of integers, which indirectly define the properties of the Curtain Wall 
Panels.

Each integer represents a Panel Class assignment for each Panel Point. (Points are defined in the 
Panel Points parameter; the set of available Classes is defined in the Panel Settings input). 
Hover to see the set of available values in the tooltip. The default “Deleted” status, which 
results in an empty panel, is always available. The other available values depend on the set of 
Panel Classes as defined in Panel Settings.

Settings Components for Curtain Wall

• The CW Settings component can be attached to any of the four CW components.

See CW Settings Component.
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Further Settings components can be attached as needed:

• Use the CW Scheme Settings component to define the pattern of the Curtain Wall Element.

See CW Scheme Settings Component.

Note: As mentioned, the CW Scheme Settings input does not affect the CW Boundary Custom 
component, which always uses an empty pattern as a starting point for the custom pattern 
(consisting of a Boundary Frame only, without any grid lines or panels).

• Use the CW Frame Settings component to set up the Frame types available for the CW Scheme: 
define Frame Classes to be used as Frame Class input parameters, thus defining the properties 
of the Frames in the CW Scheme.

See CW Frame Settings Component.

• Use the CW Panel Settings component to set up the Panel types available for the CW Scheme: 
define Panel Classes to be used as Panel Class input parameters, thus defining the properties of 
the Panels in the CW Scheme.

See CW Panel Settings Component.

For a step-by-step example, see:

Example 3: Use Rhino to Create a Custom Curtain Wall
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Zone Component

The Zone Component generates spatial units in your project, to represent rooms, wings of a 
building, blocks of a housing estate, or functional areas. ARCHICAD Zones in 3D can also be used for 
simple mass modeling; and they also form the basis of the Model Review process in the Energy 
Evaluation function. 

A Zone Component requires two inputs: the Curve input determines the Zone’s shape, while the 
Stamp Position defines the location of the Zone Stamp. 

The content of the Zone Stamp can be defined using the Zone Settings component. Connect 
additional inputs to Zone Settings to assign metadata and attributes.

See the sections on The Property Settings Component (Controlling Metadata) and the Zone Category 
Input Component.

Note: By default, Zones in ARCHICAD are visible only on the Floor Plan. To see them in the 3D 
window, go to View > Elements in 3D View > Filter and Cut Elements in 3D, and check the Zone 
item under “Element Types to Show in 3D”. 
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Object Component

AC Object components require a single input parameter: anchor point. The default Library Part type 
depends on what is set in Object Default Settings. To place a different object, attach an Object 
Settings component, and use “Select ARCHICAD Library Part” from the context menu. This 
command is available only if you have activated the “Use existing Library Part” option in the same 
context menu, as shown here:

See also The Object Settings Component (Selecting or Creating Library Parts).
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To allow Grasshopper to access the Library Part’s internal parameters, you must modify its program 
code.

Note: Library Parts are programmed using a code called “GDL” (Geometric Description 
Language.) For details, see https://en.wikipedia.org/wiki/Geometric_Description_Language.

Window and Door Components

Door/Window elements in ARCHICAD can only be placed into existing Walls – they cannot “float” 
independently of a Wall. Thus, Door and Window components require a Wall-type input. 

To create the Door/Window opening, the input data must include information on its location 
relative to the host Wall’s reference line. You can define this in two ways: via distance or a point.

• The Horizontal Distance component defines the distance between the Door/Window insertion 
point and the Wall's endpoint, along the Wall reference line.

• The Door/Window Point component defines the location of the Door/Window opening as a 
point projected perpendicularly onto the Wall reference line.

As described for the Object component, attach a Door/Window Settings component, then open the 
Select ARCHICAD Library Part dialog to choose an opening.

Note: Doors and Windows, like Objects, are Library Parts programmed in GDL (see above). For 
more information, see Accessing GDL Parameters of ARCHICAD Library Parts.
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ARCHICAD Deconstruct Components
Use the Deconstruct components to extract information from existing 
ARCHICAD elements: their reference geometry which determines their 
position, and their Settings. 

Deconstruct components are the inverse of the element-generating 
(Document and Design) components: output parameters of Deconstruct 
components are the same as the input parameters of the element-
generating components. (The Synchronize parameter, which enables or 
disables synchronization between Grasshopper and ARCHICAD, is an 
exception: this parameter is missing from Deconstruct components.)

While Deconstruct components can be applied to data generated by the Design and Document 
components, they also work on manually placed ARCHICAD elements. To refer to a placed 
ARCHICAD element: right-click on the input parameter or corresponding Parameter component to 
open the context menu, then choose the “Set one Element/Set Multiple Elements in ARCHICAD” 
command.

Note: The Deconstruct Roof component can reference only Single-Plane Roofs in ARCHICAD 
(that is, simple roofs consisting of a single plane). Roofs created with the more complex, Multi-
Plane Geometry method are currently not handled.

If the referred element is modified in ARCHICAD, click “Send Changes” on ARCHICAD’s Grasshopper 
palette to update the GH code.
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To access detailed information on the settings of the input element, go to the Deconstruct 
Component’s Settings output component, and attach the Extract Settings component to it.

See ARCHICAD Extract Settings Components, below.
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Use Deconstruct Component to Extract Brep Data
This function is available for the following ARCHICAD elements: Beam, Column, Slab, Wall, Mesh, 
Zone, Shell, Single-Plane Roof.

The Deconstruct components for these elements now include a Brep output, which contains a list 
of all of the element’s surfaces.

Wall Deconstruct Component, with Brep Output

It is also possible to extract a specific surface. From the context menu, choose “Select (Element) 
Surface Type”, shown here for a Wall:

From the appearing list, choose the surfaces you need, then click select: the surfaces are now 
added to the component:

Note: You can attach a Brep component to these outputs, thereby accessing any of the surfaces 
for further use in Grasshopper.
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Surfaces of an ARCHICAD Wall

An ARCHICAD Wall’s Specified, Highlighted Surfaces
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ARCHICAD Settings Components
Use the Settings component to define the parameters and attributes of the new ARCHICAD 
element generated by a Document or Design Component.

Each Document and Design Component includes a Settings 
parameter. Two types of components can be attached to it:

• Favorite Input Component: Use this if you want to control all of 
the new element’s parameters from Grasshopper (see Input 
Component for more information).

• Element Settings Component: Use this if you want to control only 
certain of the new element’s parameters from Grasshopper. 
Attach the corresponding element Settings component (Wall 
Settings, Slab Settings, etc.) to the Settings parameter.

Using the Element Settings component is not mandatory. If you do not use it, then the newly 
generated element will use the current Default Settings of its corresponding tool in ARCHICAD.

The right side of the Settings component has a single output parameter, which transfers the input 
data to the Design or Document component.

In many Settings components, you can change the structure or type of the generated element, 
using a context menu command. As a result, the set of input parameters available to the Settings 
Component will change (that is, new parameters will appear on the left side of the component, and 
others are removed). 

Any upstream components that were formerly connected to a removed parameter will be 
disconnected. Disconnecting components is not undoable. Therefore, the program displays a 
warning when you issue a command that will remove an input parameter. To avoid disconnecting 
components, you can press Cancel.
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The Object Settings Component 
(Selecting or Creating Library Parts)
Like other Settings components, the purpose of Object Settings is to define the ARCHICAD elements 
generated by Grasshopper. 

The Object Settings component lets you define the Library Part in two ways, from the context 
menu:

• Use existing Library Part - Choose an existing Library Part from the ARCHICAD project

• Create a new Library Part, whose geometry is defined in Grasshopper.

Use Existing Library Part

First activate this option in the context menu (as shown below).

The Select ARCHICAD Library Part command is now available: click it to bring up a dialog. On the 
left side, choose an existing Library Part. On the right side, the selected object’s internal 
parameters are displayed for your information.

On the left side of the appearing dialog box, choose among the ARCHICAD project’s loaded library 
parts. On the right side, the selected object’s internal parameters are displayed for your 
information.

It is also possible to download Grasshopper objects:

See Download Sweep and Loft Objects.

Note: By default, Grasshopper cannot access the internal parameters of ARCHICAD Library Parts 
- they are grayed out on the interface. To allow Grasshopper to access the Library Part’s internal 
parameters, you must modify its program code. 

See Accessing GDL Parameters of ARCHICAD Library Parts.
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Create New Library Part

This option lets you create a new Library Part, which will be placed in the Embedded Library of the 
connected ARCHICAD project.

With this option activated, two additional input parameters appear on the left side of the Object 
Component: Geometry and Object Name.

Use the Geometry parameter to input the shape of the new Library Part.

Note: You can add multiple shapes as input Geometry. Grasshopper handles all the inputs as a 
list, and uses them to generate a single complex Library Part. Whenever this Geometry data is 
modified in Grasshopper, the resulting Library Part is modified accordingly.

You can use the newly created Library Part immediately: as an input parameter for the Object 
generating component (in Grasshopper), or place it in the ARCHICAD project with the Object tool.

If you delete the Object Settings component in Grasshopper, the created Library Part will also be 
deleted from ARCHICAD’s Embedded Library.

The same happens if you switch the Object Settings component to “Use existing Library Part”: the 
generated Library Part is deleted from the Embedded Library, and any placed instances will be 
missing Objects in ARCHICAD.
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The Property Settings Component 
(Controlling Metadata)
The Property Settings component provides access to the metadata (e.g. Properties and 
Classifications) defined for ARCHICAD elements. With this component, it is possible to assign 
Element Classification to ARCHICAD elements or overwrite their Property values in Grasshopper.

Note: Use ARCHICAD Properties to add optional descriptive data to a building element. In 
ARCHICAD, you can list and manage Properties in the Interactive Schedule, display them in 
Labels, Zone Stamps, Door/Window Markers, import and export them among applications or to 
spreadsheets. Use the Property Manager (Options > Property Manager) to create and delete 
properties and customize their availability. Each element’s Properties are shown in the 
Classifications and Properties panel of Element Settings. Classification is also used to map 
Properties when exporting to IFC. ARCHICAD supports any number of national or company 
standard classification systems at the same time.

When first placed, the Property Settings components has no parameters. To assign Classifications 
and select Properties, use “Select Classifications and Properties” from the component’s context 
menu. In the appearing dialog, first choose one or more Element Classifications: this will determine 
which Properties can be assigned to the generated element.

Once the Element Classifications are defined, the dialog lists only those Properties that are 
available for assignment. Check the box of the Properties you wish to assign, then click OK.

The selected Properties now appear as new input parameters on the left side of the Property 
Settings component.
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Elements generated by Grasshopper are automatically given the “Grasshopper Connection” 
classification, which contains the “Grasshopper” Property group. This consists of two properties 
describing the elements’ source data: a timestamp (the last time the element was refreshed 
according to its source code) and the name of the Grasshopper source file (Grasshopper Source 
Definition).
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Note: Classifications are assigned to elements only if the name of its parent Classification 
System name is checked. An element can be assigned Classifications from multiple Systems, but 
only one Classification per System. Properties listed below are those of the checked 
Classification Systems.

Each ARCHICAD Property has one of the following Data Types:

• String: Simple text; corresponds to Grasshopper Text

• Integer: A whole number; corresponds to Grasshopper Integer

• Number: Any real number; corresponds to Grasshopper Number

• Length, Area, Volume, or Angle

• True/False: Logical value; corresponds to Grasshopper’s Boolean

• Tags List: A series of words or phrases; used to make it easier to search for elements that use 
such tags. In Grasshopper, this is achieved by assigning a series of Texts separated by semi-
colons.

• Option Set: A list of text values. The user can choose one or more of these defined options 
(multi-choice). In Grasshopper, this is achieved by entering the number of the option(s) to be 
assigned to the Property, based on the info shown in the tool tip.

Note: Whether an Option Set is multi-choice or single-choice is defined by the user in 
ARCHICAD, using the Data Type - Option Setup choices at Options > Property Manager. 

If the Option Set is multi-choice, then the Property Settings component in Grasshopper will 
expect multiple inputs in the form of “Integer as List”. (If you input multiple integers here, then 
multiple values are assigned to the Property, and the Property Settings component generates 
one output). If the Option Set is single-choice, then the Property Settings component generates 
a separate output for each input Integer.

Note: It is not possible to create a new ARCHICAD Property in Grasshopper; you can only assign 
values to existing Properties. If you need a new Property, you can create it from ARCHICAD’s 
Options > Property Manager dialog. Grasshopper is immediately updated with this new 
information: the next time you open the Select ARCHICAD Property dialog, the newly created 
Property will be listed.
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The Property Settings component’s first output parameter is “Property Settings” type. You can use 
this as an input for the Settings components of 3D elements.

The second output parameter is “Element Classification”. Use it to add a Panel component, so you 
can see the name of the Element Classification chosen in the Property Settings component.
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Curtain Wall Settings Components
In ARCHICAD, the Curtain Wall is a hierarchical tool. Thus, Grasshopper uses several interrelated 
Settings components to define the Curtain Wall element. Each level of the hierarchy has its own 
Settings component and its own set of Favorites (see Favorite Input Component). 

To create a Curtain Wall via Grasshopper, use the Curtain Wall generating components (see Curtain 
Wall Components). Using the CW Settings components is optional - for example, to use different 
settings than the default ARCHICAD ones, or to control the Curtain Wall’s subelements using 
algorithms.

CW Settings Component

Contains Settings applied to the Curtain Wall as a whole. (They correspond to the topmost level of 
the left-side tree hierarchy in ARCHICAD’s Curtain Wall Settings dialog.) At the bottom of the 
component’s parameter list, you will find the same general input parameters as in other Settings 
components: Layer, Home Story, Property Mapping, etc. At the top of the list are three specific CW 
Settings:
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Thickness

The Curtain Wall’s nominal thickness; this value is used by elements connected to the Curtain Wall 
(e.g. connecting Walls).

Refline Offset

The Curtain Wall’s vertical offset from its Reference Line. 

Scheme Settings Parameter

A special parameter with data type of “Scheme Settings”; it defines the Curtain Wall’s grid pattern: 
the pattern of Frames, and thereby the geometry of the Panels. Scheme Settings also assigns Frame 
and Panel Classes to these subelements, thus defining their appearance. Use the Scheme Settings 
component or Favorite Input component to assign these values.

Note: CW Scheme Settings does not affect the CW Boundary Custom component, which 
generates a custom pattern rather than the pattern defined in Scheme Settings.

CW Scheme Settings Component

The Curtain Wall Scheme is a unit pattern, which is repeated over the length and height of the 
ARCHICAD Curtain Wall to fill out the surface with Frames and Panels. Thus, this component 
defines the Curtain Wall pattern and the Frame and Panel types. 

Use this component to control the parameters found on the Scheme Settings page of ARCHICAD’s 
Curtain Wall Settings.
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The following input parameters define the Scheme’s grid pattern:

Vertical and Horizontal Grid Pattern

Expects a list of real numbers that define the CW Scheme’s pattern via the number and size of the 
grid cells.

Example: The Horizontal Grid Pattern value is A, B. The Vertical Grid Pattern value is 1, 2, 3. The 
result is a Scheme with a total of 2x3, that is 6 grid cells.

Crossing Frame Pattern

Expects a list of Boolean values. Use these to define the direction of the Crossing Frame placed 
inside a given panel of the grid: from lower left to upper right corner, or from upper left to lower 
right corner. The number of values entered must correspond to the number of Scheme cells even if 
you do not want to place a Crossing Frame in each panel. (The Crossing Frame Class parameter 
defines whether to place a Crossing Frame or not; see below.)

Frame Settings and Panel Settings

Use these parameters to define the types of Frames and Panels to use. Consider it as a product 
catalog: each Frame Class and Panel Class has a particular geometry and appearance. The architect 
can choose among these to design the Curtain Wall; not all items in the catalog must be used. (In 
Grasshopper, these are defined in the Frame Class and Panel Class input parameters - see below.)

Assign values to the Frame Settings and Panel Settings input parameters using the “CW Frame 
Settings” and “CW Panel Settings” components, or the Favorite Input Component. Each such input 
adds a new item to your “catalog” of projects - that is, to the available Frame and Panel Classes. 

See details at CW Frame Settings Component and CW Panel Settings Component.
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Frame Classes

The Frame Class, assigned to the Frame’s axis, defines the appearance and profiles of Frame 
geometry. A Curtain Wall can use five kinds of Frames: Boundary, Corner, Vertical, Horizontal and 
Crossing. Thus, the CW Scheme Settings component uses five Frame Class input parameters, each 
of which expects an integer-type value. Each integer refers to one of the Frame Classes as defined 
in the Frame Settings input parameter. Hover over the Frame Class parameter to see available 
input values in the tooltip.

If Frame Settings inputs do not have any values attached, you can still choose from predefined 
Frame Class parameters which are always available: -3 (= Corner), -2 (= Boundary), -1 (=Division) 
and 0 (= None). This is the predefined set of Frame Settings, which can then be expanded with 
additional Frame Settings inputs.

• Boundary Frame Class

This is the Frame that forms the Curtain Wall’s outside Boundary. Though a Boundary Frame 
consists of multiple segments, all segments have a uniform appearance, so the Boundary Frame 
Class parameter requires a single integer as input.

• Corner Frame Class

Corner Frames may be generated within a Curtain Wall - for example, if the Curtain Wall is 
generated along a segmented polyline. Where the planes meet, Curtain Wall segments are 
joined via Corner Frames. Like Boundary Frames, Corner Frames are uniform for the entire 
Curtain Wall element, so the Corner Frame Class parameter requires a single integer as input.

• Vertical, Horizontal and Crossing Frame Class

The Grasshopper algorithm considers that each Scheme cell contains a Vertical, a Horizontal 
and a Crossing Frame segment. The corresponding input parameters thus expect a list of 
integers - one for each cell in the Scheme. If the input list contains more or fewer numbers than 
the number of Scheme cells, then the CW Scheme Settings Components automatically truncates 
or augments the input list using a default integer (in this case, a yellow info pop-up appears).

Panel Class

Assigning the Panel Class input to a panel’s boundary defines that panel’s appearance and cross-
section. Since the Curtain Wall has one Panel type (as opposed to the Frame, which can be e.g. 
Boundary or Crossing), the CW Scheme Settings component has a single Panel Class input, which 
expects integer values. Each input integer refers to a particular Panel Class, as set up in the CW 
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Panel Settings component. Hover over the Panel Class tooltip to see the list of available integers 
and what they mean.

If Panel Settings contains no values, the Panel Class input can always use the default value of 0 
(=Deleted). This basic setting is always available; you can expand this set by inputing values into 
Panel Settings.

For the purposes of control from Grasshopper, each Scheme cell contains two panels - because of 
the possibility that a Crossing Frame creates two panels (this is the case even if the Crossing Frame 
value is 0 (= None), that is, if the Crossing Frame is invisible). Therefore, the Panel Class parameter 
input expects a list of integers whose number is equal to the number of cells in the Scheme (as 
indicated above, this number is doubled to account for Crossing Frames). If the number of input 
integers is less than this number of panels, then the leftover values are set to 0 = Deleted. If the 
number of input integers exceeds this number of panels, then the extra values are ignored - as 
indicated in a yellow warning pop-up.

CW Frame Settings Component

Use this component to control the editable parameters of Frame elements in the connected 
ARCHICAD project.

Attach the CW Frame Settings component to the Frame Settings input of the CW Scheme Settings 
Component: the Frame can now be referenced and accessed by the Frames of the Curtain Wall.

See CW Scheme Settings Component.

• Class Name: Class Name of ARCHICAD Frame Settings.

• Width/Depth: The Frame’s Width and Depth values. The value must be a positive number (a 
negative input value is interpreted as zero in ARCHICAD). If the input value is invalid, a yellow 
warning appears. 

• Offset: Frame back offset from panel centerline. The value must be a positive number, and it 
must be less than the Depth value. If the input value is invalid, a yellow warning appears. 
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• Depth of Inset/Width of Inset: The value of the Panel inset must be a positive number. If the 
input value is invalid, a yellow warning appears.

• Intersection Priority: Controls the ARCHICAD Frame’s intersection behavior. The input value 
must be a positive whole number between 1 and 19. If the input value is invalid, a yellow 
warning appears.

CW Panel Settings Component

Use this component to control the editable parameters of Panel elements in the connected 
ARCHICAD project. 

Attach the CW Panel Settings component to the Panel Settings input of the CW Scheme Settings 
Component: the Panel can now be referenced and accessed by the Panels of the Curtain Wall.

See CW Scheme Settings Component.

• Class Name: Class Name of ARCHICAD Panel Settings.

• Thickness: The Panel’s Thickness.
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The Profile Settings Component
Use this component to access and adjust the Modifiers (if any) of Complex Profile elements in 
ARCHICAD.

Example of a Profile Element with Modifiers

Note: The Profile Settings component can be used only if the “Structure” parameter of the 
Wall/Column/Beam’s Settings component is set to “Complex Profile.”
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When first placed, the Profile Settings component has no parameters.
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To assign Profile and Modifiers, use “Select ARCHICAD Profile” from the component’s context 
menu.

In the appearing dialog, first choose a Profile: this will determine which Modifiers can be assigned 
to the generated element. These available Modifiers are now listed. Check the box of the Modifiers 
you wish to assign, then click “Select”.
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The selected Modifiers now appear as new input parameters on the left side of the Profile Settings 
component.
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ARCHICAD Extract Settings Components
Use the Extract Settings components to access the Settings data of ARCHICAD elements. 

Extract Settings are the inverse of Settings: Extract Settings output 
parameters are the same as the Settings input parameters.

As input, you can attach Deconstruct components to Extract Settings. The 
output of Extract Settings is a fixed list of parameters. If a particular 
output is not applicable to the given element geometry, then the output 
value is “NULL”.

For example: The output from the Extract Wall Settings component 
includes parameters for Building Material, Profile and Composite. Yet any 
Wall element can have only one of these three values, depending on its particular structure. The 
other two parameter values here are “NULL”.
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ARCHICAD Reshape Components

Subtract Polygon Component

This component is used to cut a hole of any shape into an existing Fill, Slab or Single-plane Roof 
element. First, connect the element to be modified to the Geometry parameter. Next, using the 
Curve parameter, define the contour of the hole as projected to the horizontal plane.

The output will be an element of the type defined in the Geometry parameter, with a hole in it.

Notes:

– The Curve input defines the contour of the hole as projected onto the horizontal plane. 
Therefore, on a slanted Roof, the hole is created by intersecting the Roof with the straight 
prism defined by the Curve input.

– If you input a Curve that falls outside of the element in which the hole is to be cut, then the 
Subtract Polygon component will result in another copy of the element to be cut, in 
unchanged form (no hole).

Add Polygon Component

This component works just like the Subtract Polygon component, except that it adds to the contour 
of the Fill, Slab or Single-plane Roof, instead of subtracting from it.
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ARCHICAD Input Components
Input Components are special interface elements that reference certain data 
from the ARCHICAD project, making these data available to Grasshopper. The 
referenced data are continuously updated. Input Components can be 
attached to Settings components to control attributes – such as Building 
Material, Composite, Pen etc. – or the destination Layer of the generated 
elements. An exception is the Favorite Input Component, which can be 
attached (instead of a Settings component) to the main Design or Document 
component.

An Input Component is divided into two parts: click on its left side to select the Component itself; 
click on its right side to modify its stored data.

Layer Input Component

Use the Layer Input Component to bring up the 
ARCHICAD layer set in Grasshopper so you can define 
the layer where elements generated by Grasshopper 
should be placed. The Layer selection palette also 
includes the layers’ status (show/hide, lock/unlock 
and 3D display mode). Sort the layer list as needed 
(click the top of any list column) to make layer 
selection easier.

Nearly all Settings components include a Layer-type 
input (except the Settings components of CW Panel 
and CW Frame).

Fill Pattern Input Component

Through this Component, the Fill Type attributes of the current ARCHICAD project are made 
available to Grasshopper. At present, only the Fill Settings component can use this type of input. 
Use it to control the fill pattern of elements generated by the Fill component.
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Note: The Fill Pattern Input Component can be attached to the Fill component only if you have 
selected an option other than the “Cut Fill – Building Material” category from the Fill 
component’s context menu (because the Building Material already includes the fill pattern.) For 
more information on Fill categories, see helpcenter.graphisoft.com.

Pen Input Component

Accesses the Pen attribute set of the connected 
ARCHICAD project. Currently, this Input Component 
is available for the Fill, Polyline and Spline Settings 
components.

Font Name Input Component

Lists all fonts installed on your computer by name.

A sample text at the top gives you a preview.

Line Type Input Component

Lists the Line Type attributes of the ARCHICAD project. Currently, the Fill, Polyline and Spline 
Settings components accept this type of data.

Surface Input Component

Accesses the Surface attribute set from the connected ARCHICAD project. Currently, this Input 
Component is available for only the CW Frame Settings and CW Panel Settings components.
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Building Material Input Component

Lists the Building Material attributes of the ARCHICAD project.

Most Settings components of 3D elements include this type of input. Elements that can have 
composite or profile structures (Wall, Slab, Shell, Roof, Beam, etc.) will include the Building 
Material Input Component only if the Structure value is set to Basic. If the Structure value is set to 
Composite or Complex Profile, then the Profile or Composite Input Component will be available 
instead.
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Profile Input Component

Lists the Complex Profiles defined in the ARCHICAD project. Use it to define the cross-section of a 
Wall, Beam, or Column element that has a Complex Profile structure.

Click the right side of the Profile Input Component 
to open the selection palette. Filter the list by 
using the element type buttons at the top left 
corner of this palette.

Click the button at the bottom left to display the 
list by either Icon or List format.

Note: If all three element-filter buttons are 
active at top left, then you will see the full list 
of profiles. If only the Wall button is active, 
then only the profiles available for Walls are 
listed.

Composite Input Component

Lists the Composite attributes of the ARCHICAD 
project. Available in the Settings components of 
Walls, Shells, Roofs and Slabs whose Structure is 
set (in their context menu) to Composite.

2D Viewpoint Input Component

Use the 2D Viewpoint Input Component to access the Viewpoints of the current ARCHICAD Project. 
By attaching this component to the Document components (2D Curve, 2D Fill, 2D Spline), you can 
control the 2D Viewpoint in which the 2D elements should be generated in the ARCHICAD project. 
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Open the Component’s palette to access a tree structure corresponding to the ARCHICAD Project 
Map. Note that only the 2D views are available (Section/Elevation, Floor Plan, etc.); no 3D views are 
available.

Story Plane Input Component

Produces horizontal planes (parallel to the X-Y plane) based on the Story heights of the ARCHICAD 
project. Use these planes to define the reference input curves of the element-generating 
components: this way, the elements (e.g. Wall, Slab, Beam) will be generated in ARCHICAD at the 
correct elevations.

Zone Category Input Component

Attach this Input Component to the Zone Settings component to define the Zone Category of the 
generated ARCHICAD Zone element. 
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The main function of Zone Categories is to use colors to visually distinguish different types of spaces 
in your project.

Favorite Input Component

Lists the set of Favorites of the ARCHICAD project.

Note: In ARCHICAD, the Favorites feature allows you to save sets of configured tool settings by 
name. For more information, visit helpcenter.graphisoft.com. 

Unlike the other input components, the Favorites Input Component is attached not to the Settings 
Component, but directly to the Document or Design Component (“Settings” parameter) which 
generates the element. By attaching the Favorite Component (instead of a Settings component), 
you are thereby defining all parameters of the generated element in one step.
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Note: The 3D position of elements generated by Grasshopper (such as the Offset from Home 
Story parameter in the Settings dialog) are defined in the mandatory input data of the 
Document and Design components, which generate the element. (For example, the elevation of 
a generated Slab is determined by the Curve parameter of the Slab component.) Such 
mandatory input data are not affected by Favorite settings.
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Workflow Examples

Example 1: Use Rhino to Create Freeform Shading System

In this workflow, we create the geometry using Rhino’s freeform modeling capabilities, while also 
taking advantage of ARCHICAD’s BIM capabilities. The task is to design a shading system that 
extends between two curved splines.

1. Begin in Rhino: create the 3D curved splines.

2. In Grasshopper, use these freeform geometries as the input parameter.

3. Use the Divide Component to generate the division points needed for the shading system.

Splines drawn in Rhino with the Curve command
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4. At each division point, place an AC Column component; at each spline, place an AC Beam 
component.

Generated BIM model in ARCHICAD based on 3D Rhino curves

5. You can fine-tune the geometry in Rhino by adjusting the original spline geometry (use the 
PointsOn command).

6. To define the Building Material attribute or Core Dimensions of the generated Columns, attach 
a Column Settings component to the corresponding parameter of the Column component.
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Example 2: Use ARCHICAD Input to Build a Parametric Tower

In this workflow, parametric design is based on an existing ARCHICAD project, using input that 
originates in ARCHICAD.

The task is to create a mass model of a high-rise atop a six-sided base, which has already been 
defined in ARCHICAD. 

1. In Grasshopper, use the 2D Curve parameter component to reference the six-sided geometry in 
the ARCHICAD project.

2. Create an array of the polyline to draw the outline of the slabs on each story.

The cross-section of the tower is defined in ARCHICAD

3. Apply a rotation transformation to the array of polygons to create a more complex shape.

4. Use the rotated collection of polygons as the input parameter for an AC Slab component to 
create slabs on each story, which can be adjusted as needed using the transformation features.
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5. Create division points along the slab outlines: these will constitute 3D curves.

Slabs of the tower generated in ARCHICAD
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6. Use these curves as input parameters for AC Beam components to model the building’s twisting 
frame.

The division points along the slab outlines define 3D curves.
AC Beam components attached to these points create the twisted frame in ARCHICAD.

7. At any time, you can edit the original six-sided polyline in ARCHICAD, thereby modifying the 
cross-section of the entire high-rise: the 2D Curve parameter, the basis for the Grasshopper 
code, remains associated to its parent element in ARCHICAD.

If you edit the original polygon in ARCHICAD, and then press the Send Changes button on the 
Grasshopper Connection Palette, the model’s entire geometry is modified accordingly: the 2D 
Curve parameter is associative to its parent element.
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8. To change the cross-section of a Beam, attach a Beam Settings component to the Beam 
component’s Settings parameter. From the Beam Settings context menu, click on “Structure of 
ARCHICAD Beam”, and select Complex Profile. As a result, the set of input parameters of the 
Beam Settings input is modified and now includes the “Profile” parameter on the left side.

9. Attach a Profile Input Component to the Profile parameter. Click on the right side of the Input 
Component to bring up the Profile Selection palette, which lists all the profiles defined in the 
ARCHICAD project. In the upper left of this palette, deselect the Wall and Column elements, so 
that only profiles defined for Beams are visible, making it easier to choose the right one.
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Example 3: Use Rhino to Create a Custom Curtain Wall

In this workflow, we generate a custom Curtain Wall from a curve defined in Rhino.

1. Begin in Rhino: Create the spline and a point.

2. In Grasshopper, use these geometries as the input parameter.

3. Use the Construct Domain Component to define the Curtain Wall height.

4. Place the Curtain Wall generating component and attach the inputs:

Grasshopper Code with Rhino Input Elements
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Resulting Curtain Wall, with Default Settings

5. Attach and define the CW Settings Component:
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6. Attach the CW Scheme Settings Component to the corresponding input, then use it to define the 
Pattern.

In our example, create a 2x3 pattern, consisting of 2 vertical and 3 horizontal divisions.

7. Define the Crossing Frame Pattern. (If you don’t need a Crossing Frame, define it anyway: set its 
class to 0=None). With the Crossing Frame, the divisional pattern 2x3=6 is now doubled to 12, 
so the program now considers the pattern to contain 12 Panels.
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8. The Frame Settings input can be of two types:

• CW Frame Settings Component (see below), or

• Favorite Input Component (see description at Favorite Input Component). This enables access to 
the existing CW Frame Favorites of the connected ARCHICAD project.

In our example, one Frame and one Favorite have been attached:

9. Similarly, the Panel Settings input can be of two types:

• CW Panel Settings Component (see Step 13 below), or

• Favorite Input Component (see details at Favorite Input Component). This enables access to the 
existing CW Panel Favorites of the connected ARCHICAD project.

In our example, one Panel and three Favorites have been attached:

10.  Define Corner Frame Class and Boundary Frame Class, using the set of Frame types defined via 
Frame Settings.

Choose one Frame Type for each of these classes as follows:

• Right click to open the context menu

• Choose Set Integer
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• Enter the code corresponding to the Frame Type

11. Define Crossing Frame Class, Vertical Frame Class, and Horizontal Frame Class, using the set of 
Frame types defined via Frame Settings:

For each Frame Class (Crossing, Vertical, Horizontal):

• Right click to open the context menu

• Choose Set Multiple Integers

• Enter the codes corresponding to the Frame Types - one code for each (in this case, six):
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Crossing, Vertical and Horizontal Frames
Grasshopper-ARCHICAD Live Connection 2.3 User Guide 81



Workflow Examples
12. Define Panel Class:

Using the set of Panel types defined via Panel Settings, choose one Panel Type for each, as follows: 

• Right click to open the context menu

• Choose Set Multiple Integers

• Enter the codes corresponding to the Panel Types - one code for each Panel. In this case, there 
are 6 divisions in the Scheme; due to the Crossing Frame, each division consists of two 
elements, for a total of 12 Panel elements.
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13. Attach the CW Frame Settings Component as an input to the CW Scheme Settings Component, 
via the Frame Settings input. This enables access to the existing Frame Types of the connected 
ARCHICAD project. You must enter the Class Name; all other parameters are optional.
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14. Attach the CW Panel Settings Component as an input to the CW Scheme Settings Component, 
via the Panel Settings input. This enables access to the existing Panel Types of the connected 
ARCHICAD project. You must enter the Class Name; all other parameters are optional.

15. The custom Curtain Wall is complete.
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Parametric Behavior of Generated Elements

• Unlike geometry that is embedded using Rhino’s “Bake” command, elements generated in 
ARCHICAD remain associated to their generating code. Grasshopper uses an ID-based method 
to retain its connection to elements placed in ARCHICAD. If the Grasshopper file is modified, the 
ARCHICAD-Grasshopper Connection Tool will update the corresponding elements in ARCHICAD.

• Elements generated by Design or Document Components in ARCHICAD are not just previews: 
they are real, editable ARCHICAD elements. When Grasshopper creates these elements, their 
status is locked. After you unlock them (Edit > Locking > Unlock), you can open their Settings 
dialog in ARCHICAD in the usual way, and modify their parameters. You can also edit the 
elements graphically.

• The locked status of elements generated by the Grasshopper code is similar to the “preview” 
status in Rhino. Parameters of locked elements can be modified only through the Grasshopper 
code. After the elements are unlocked, their parameters can be modified in ARCHICAD.

• By default, a generated AC element’s parameters which are not controlled by the GH code will 
have the same settings as the Default Settings of the corresponding tool in ARCHICAD at the 
time the element was generated.

• Certain parameters of generated AC elements (those which are used in the component of the 
generating component or their Settings components) can be edited in Grasshopper, as well as 
in ARCHICAD after the elements are unlocked. However, the Grasshopper-based parameter 
control takes priority over that in ARCHICAD as long as the GH-AC Connection is active. If a 
parameter of an AC component in Grasshopper is assigned a value (e.g. you add a Number 
Slider), then that value will be applied every time the Grasshopper code is executed. If you 
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previously assigned a custom value to that element parameter in ARCHICAD, then that custom 
value, too, will be overridden when the Grasshopper code is executed.

• If you modify the parameter of a generated element in ARCHICAD using the element’s Settings 
dialog box, and if that parameter is not controlled in Grasshopper (either because the 
parameter is not available in the generating component or because the parameter has no 
assigned value in GH), then your modification remains in effect, even if the Grasshopper code is 
executed.

• If the GH-AC Connection is not active, then the GH code has no effect on the ARCHICAD project. 
You can then freely modify even those elements originally generated by Grasshopper code. 
However, once you reactivate the GH-AC Connection, the GH code again takes precedence in 
terms of controlling the parameters.

• If you use copy-paste to replicate elements in ARCHICAD which were generated from GH code, 
then the duplicates will lose their connection to the Grasshopper code. Use this method to 
create and compare various designs by trying different values for the Grasshopper parameters.

• Suspended Connection: As long as a dialog box is open in ARCHICAD, awaiting user input, the 
connection between Grasshopper and ARCHICAD is suspended. Even if the user changes an 
input value in Grasshopper, the change will not take effect until the dialog box in ARCHICAD is 
closed. Feedback on the suspended connection is shown in ARCHICAD’s Grasshopper Palette: 
the green connection icon stops spinning. In Grasshopper, the components with pending input 
in ARCHICAD’s direction will turn yellow. A message also pops up to inform the user of which 
dialog must be closed before the Grasshopper ARCHICAD Connection is resumed.

File Handling

• Elements generated by the Grasshopper code are fully functional, native ARCHICAD elements 
that remain in the project even if the GH code is not available. Thus, an ARCHICAD project that 
includes elements generated from GH code requires no additional management. It can be saved 
as usual to any of the available formats. You can reopen the project without any problem even 
if the original Grasshopper code is not available (the elements generated from GH code will be 
still be present in the project). 

• In contrast to ARCHICAD, Grasshopper can have several projects (GH definitions) running 
simultaneously in a single instance of the application. However, only one of these files can 
communicate with ARCHICAD at a time. To define which of the running Grasshopper files 
should be connected to ARCHICAD, use the “Connect Document to ARCHICAD” dialog box, 
available from Grasshopper’s File menu. 
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The path of the currently active document is shown in bold.
The green icon indicates which definition is currently connected to ARCHICAD.

• If you connect an ARCHICAD PLN project to the Grasshopper file which contains the elements’ 
origin code, the two files recognize each other, and you can continue your parametric design. 
For this reason, it is recommended to save these file pairs to a single folder, and to use related 
file names.

• It is currently not possible to use the ARCHICAD-Grasshopper Connection in a Teamwork setup 
(that is, with ARCHICAD and Rhino installed on different computers). An ARCHICAD file that 
contains elements generated from GH code can be shared as a Teamwork file, like any other 
ARCHICAD project, if the GH-AC Connection is disabled.
Grasshopper-ARCHICAD Live Connection 2.3 User Guide 87



Accessing GDL Parameters of ARCHICAD Library Parts
Accessing GDL Parameters of 
ARCHICAD Library Parts
By default, Grasshopper cannot access the parameters of ARCHICAD Library Parts. However, you 
can modify a Library Part’s GDL code to allow Grasshopper to access the object’s GDL parameters 
(see steps below). This is recommended for users familiar with GDL programming.

Note: Geometric Description Language (GDL) is the programming language of ARCHICAD library 
parts. These library parts, with file format GSM, can be loaded into your ARCHICAD project 
through the Library Manager. When you open a new project with a default template, a standard 
ARCHICAD Library is automatically loaded.

To modify an existing Library Part to enable Grasshopper to access its parameters:

1. Go to File > Libraries and Objects > Open Library Part.

2. Select the Library Part that you want to edit.

3. Click View or Open.

4. The GDL Editor is opened in a new tab, where you can edit the object’s GDL code.

5. Click on the Parameters button (at left) to open the object’s parameter list.

6. Click New (at top left) to add a new parameter to the list. 
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7. Set up this new parameter as follows:

Display: activate the red cross pushbutton to make the variable invisible on the user interface.

Variable: type "ParamcontrolByGrasshopper"

Type: Boolean

Name: enter any name

Value: ON 

8. After the new parameter is set, use File > Save as to save the Library Part under a new name to 
the Embedded Library.

The newly modified, duplicate element is now available in Grasshopper. 

9. In Grasshopper, place an Object Settings component on the canvas.

10. From the context menu, choose Select ARCHICAD Library Part.

11. From the appearing dialog, browse for the new element. Since Grasshopper detects the 
ParamcontrolByGrasshopper parameter, the object’s GDL parameters are selectable on the 
right. Every parameter that you check here will (after you click Select in the dialog box) appear 
as an input parameter on the left side of the Object Settings component. From this point on, 
you can define these GDL parameters, too, in Grasshopper.
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Note: Be careful when managing GDL objects via Grasshopper. Library part parameters are 
often interdependent, and modifying one value will modify other values too. Grasshopper does 
not detect this interdependence. If you adjust several values in Grasshopper which are 
interdependent, an error may occur, if both Grasshopper and the GDL Parameter script seek to 
modify the interdependent values simultaneously.

If contradictory information is given as parameter inputs for Library Elements in Grasshopper, 
then objects may be placed differently than expected. The most common phenomenon that is 
that Objects are not updated when a parameter is changed in Grasshopper. In case of Doors/
Windows, the settings dialog can misbehave when you try to edit the elements manually.

Recommendation: Do not use Grasshopper to modify multiple GDL parameters simultaneously 
if their values are interdependent. 
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Download Sweep and Loft Objects
Enhance your BIM model with the newly developed Grasshopper Sweep and Loft Objects, to 
represent and document complex shapes that cannot be defined easily with default ARCHICAD 
tools.

Download these objects from BIMcomponents.com.

BIM Components is a public website containing GDL objects and surfaces. Anyone can access the 
portal to browse, search, view and even download these files for free.
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